Creating an agent-based backup system for IBM PureApplication System

Katherine J. Lamendola (kjlamend@us.ibm.com)  
Software Engineer  
IBM

Jeffrey T. Klier (jtklier@us.ibm.com)  
Software Engineer  
IBM

22 October 2014

This article shows you how to use IBM Endpoint Manager to deploy and configure IBM Tivoli Storage Manager backup agents on virtual machines that are running in an IBM PureApplication System cloud. Distributing backup agents to virtual machines is essential when they are hosting critical workload data, and this article shows you how to simplify this formerly arduous task.

Introduction

In a cloud computing system, application workloads run on virtual machines that may host a variety of middleware, including web applications, databases, and user registries. Cloud administrators should create backups of any critical workload data, in case of corruption or system failure.

There are two general ways to perform backup operations: agent-based and agent-less. In an agent-based system, backup and recovery agents are installed on each virtual machine. The agents collect data and transfer it over the network to a central backup server. IBM® Tivoli® Storage Manager and Symantec Netbackup are examples of agent-based backup systems.

Agent-less systems use programming interfaces such as VADP or Microsoft VSS to perform backup and restore operations across the network. These interfaces do not require a permanent agent to be installed on the virtual machine. They may, however, inject temporary agents into the virtual machine while performing a backup operation. Asgira is an example of an agent-less system.

An agent-based system is more difficult to manage than an agent-less system. Cloud administrators must handle the installation and maintenance of an agent on each virtual machine.
In addition, security configuration on the virtual machines is often impacted by the agent, because a port in the firewall must be opened for the agent to communicate with its central server. However, agent-based backup is often a more flexible solution for virtual machines that run applications such as databases. An agent can back up and restore granular object data for applications, whereas an agent-less system is typically used for full recovery of a virtual machine and its disks.

To ease the difficulty of managing an agent-based system, you can include backup agents as part of the virtual machine template in a cloud. Alternatively, you can use systems management tools such as IBM Endpoint Manager for Lifecycle Management to distribute backup agents to all virtual machines, and to manage all agents from a single console. This article shows how IBM Endpoint Manager deploys backup agents to virtual machines running in an IBM PureApplication System cloud.

Architectural overview and flow of an agent-based backup system

Figure 1. Example of an agent-based backup system in a cloud environment

Process flow:

- The IBM Endpoint Manager Shared Service automatically installs the IBM Endpoint Manager Client onto all future deployments.
- New deployments then become visible on the IBM Endpoint Manager Console under the Discovered Computers list.
- The IBM Endpoint Manager Console is used to install Tivoli Storage Manager backup agents to the virtual machines.
- The Tivoli Storage Manager Console is used to manage backups.

Figure 1 represents the architecture of an agent-based backup system in a cloud environment. Each virtual machine that is hosting critical workload data must have a backup agent installed. You can pre-install the agent as part of a virtual machine image, locally install the agent after deploying the virtual machine, or remotely install the agent using a systems management tool such as IBM Endpoint Manager.

Backup agents transfer data out of the cloud to an external backup server. Typically, you must configure the agent during or after installation to communicate with the backup server, and configure the virtual machine firewall to permit communication between the agent and the backup
server. This article shows you how to use IBM Endpoint Manager to simplify the deployment and configuration of backup agents in a cloud, including:

- Integrating IBM Endpoint Manager with a cloud running on IBM PureApplication System.
- Packaging an IBM Tivoli Storage Manager backup agent.
- Deploying an IBM Tivoli Storage Manager backup agent.
- Configuring an IBM Tivoli Storage Manager backup agent.

Overview of IBM Endpoint Manager, IBM PureApplication System, and Tivoli Storage Manager

IBM Endpoint Manager for Lifecycle Management is a technology for enterprise systems management. IBM Endpoint Manager provides a number of services, including inventory, software distribution, operating system deployment, patch management, and remote desktop control.

IBM PureApplication System is a cloud computing system-in-a-box, providing a standardized cloud application platform for your web and database applications.

IBM Tivoli Storage Manager is a data protection platform that includes backup and recovery agents.

Integrating IBM Endpoint Manager with a cloud running on IBM PureApplication System

IBM PureApplication System can be configured to automatically add IBM Endpoint Manager support to all virtual machines running on a cloud. You can then use the IBM Endpoint Manager console to manage your IBM PureApplication System virtual machines.

You should already have an IBM Endpoint Manager Server for Lifecycle Management installed and configured on a system external to your IBM PureApplication System environment. You can also download IBM Endpoint Manager Server, but before you can install it, you must obtain a license key. For information on how to do this, see IBM Tivoli Endpoint Manager -- Licensing. For additional information about licensing, see the IBM Endpoint Manager Administrator's Guide.

IBM Endpoint Manager Server prerequisites

- For installation and configuration guides, including configuration of the Lifecycle Management Domain, see IBM Endpoint Manager V9 Information Center.
- Enable the Upload Maintenance Service, which detects when uploads have completed, and changes the file status from Uploading to Complete. To enable the Upload Maintenance Service, click the link in the Actions box on the IBM Endpoint Manager Console under Systems Lifecycle domain, TEM Server: Install TEM Upload Maintenance Service for Software Distribution.
- Install the Software Distribution Plug-in to enable SWDProtocol. Navigate to the Setup node of the software distribution site, and run the TEM Server: Register Download Plug-
in for Software Distribution operation on your IBM Endpoint Manager server. If an error occurs during the fixlet action, similar to the example shown in Figure 2, install the Software Distribution Plug-in:

**Figure 2. Example of error when SWDProtocol is not installed and enabled**

![Error Example](image)

To integrate IBM Endpoint Manager with IBM PureApplication System, deploy the IBM Endpoint Manager Shared Service in the IBM PureApplication System environment, using the steps below. A shared service is a predefined virtual application that is deployed and shared by all virtual machines in a cloud. Shared services are shipped with IBM PureApplication System, including the IBM Endpoint Manager shared service.

1. Log in to the IBM PureApplication System Workload Console.
2. Navigate to [Cloud → Shared Services](#).
3. Select [IBM Endpoint Manager Service 1.0.1.0](#) from the list of available shared services, as shown in Figure 3. The details about the selected shared service are displayed, and a Deploy icon is enabled in the tool bar.
4. Click [Deploy](#) to deploy the IBM Endpoint Manager shared service.
Figure 3. Displaying details about the selected IBM Endpoint Manager shared service

5. The Deploy Pattern page is displayed, as shown in Figure 4. In the IBM Endpoint Manager server masthead file field, click **Browse** to specify the masthead file that was created when you installed the IBM Endpoint Manager server:
Figure 4. Specifying options for deploying the IBM Endpoint Manager shared service

6. Select the local masthead file ActionSite.afxm for your IBM Endpoint Manager Server, located in the `<Install_Root>\BES Server` directory, as shown in Figure 5. Click **OK**. Default deployment options are automatically populated in the Configure options.
7. Click **Quick Deploy** to proceed with deploying the IBM Endpoint Manager shared service.

The deployed IBM Endpoint Manager shared service instance acts as a relay between the IBM Endpoint Manager Server and all future virtual machine deployments within the cloud. IBM Endpoint Manager discovers any virtual machines that you deploy as part of an application workload. If a virtual machine is not displayed in the list of discovered virtual machines, ensure that the IBM Endpoint Manager Client (under the process name BESClient) is started and running on the given virtual machine. You can view and manage discovered virtual machines from within the IBM Endpoint Manager Console, as shown in Figure 6 under Computers:
Using IBM Endpoint Manager to package a Tivoli Storage Manager backup agent

Before you can deploy backup agents to IBM PureApplication System virtual machines, you must first use the IBM Endpoint Manager Console to create a Software Distribution Package for the backup agent. Use the following procedure to create and upload the package, using IBM Tivoli Storage Manager Client V6.3.2 as the backup agent.

1. Download the Tivoli Storage Manager V6.3.2 Client. For information about supported clients and devices and any licensing requirements, see the IBM Tivoli Storage Manager Support Portal. Download the client software to match the operating system that your virtual machines are running. The operating system is displayed for each virtual machine on the IBM Endpoint Manager Console in the discovered Computers list under OS.
2. Extract the client software to a local directory on the system where you have installed the IBM Endpoint Manager Console.
3. Log in to the IBM Endpoint Manager Console and select the Systems Lifecycle domain.
4. Navigate to Software Distribution → Manage Software Distribution, as shown in Figure 7:
5. Click **New Package** to create a new package. Enter the following values:
   - **Vendor:** IBM
   - **Product:** Tivoli Storage Manager Client
   - **Version:** 6.3.2

6. Click **Confirm** to finish creating the package.

7. In the Package Library table, select the new package that you just created. A second table is displayed, entitled Files in Package "Tivoli Storage Manager Client," as shown in Figure 8:

   **Figure 8. Manage software distribution packages**

8. Click **Add Files**. The Add Files to Package dialog is displayed. Select **Add Folder**, as shown in Figure 9, and enter the path to the directory where you extracted the Tivoli Storage
Manager Client software. Select **Compress folders at depth** and specify 0 as the depth, so that all files in the directory are compressed during the upload of the package to the IBM Endpoint Manager Server.

**Figure 9. Adding files to the Software Distribution Package**

9. The Tivoli Storage Manager Client software is uploaded to the IBM Endpoint Manager Server under the file name `compressedPackageData.bftemp`. This file is displayed in the Files in Package Tivoli Storage Manager Client table. While the upload is in progress, the File Status column displays a yellow icon. When the upload completes successfully, the File Status displays a green icon, as shown in Figure 10:
Figure 10. File upload completed successfully

![Image of IBM Endpoint Manager Console]

10. Move the cursor over the compressedPackageData.bftemp file in the File Name column. A pop-up is displayed showing the SHA1 checksum value of the file:

**Figure 11. SHA1 checksum value**

![Image of SHA1 checksum value]

The uploaded package data now resides on the IBM Endpoint Manager server at the following location:

\(<Install_Root>/wwwrootbes/Uploads/<SHA1_value>/compressedPackageData.bftemp.bfswd\)

The file size (in bytes) is also displayed. Record the file size of the package data and this checksum value for later use.
Overview of IBM Endpoint Manager fixlets

After you create and upload the Software Distribution package defined for the Tivoli Storage Manager Client, IBM Endpoint Manager can remotely install the package on IBM PureApplication System virtual machines using an IBM Endpoint Manager fixlet.

IBM Endpoint Manager fixlets identify virtual machines affected by a particular issue, such as missing software, a missing patch, or a security vulnerability. A fixlet is packaged with an Action Script that can resolve the issue. The IBM Endpoint Manager Console can execute the Action Script remotely on virtual machines that are affected by the issue. Using fixlets simplifies the deployment of a backup agent, because it shows you which virtual machines in your cloud are missing the backup agent, so you can deploy the agent software remotely.

To install the Tivoli Storage Manager Client on IBM PureApplication System virtual machines, you use a fixlet to identify virtual machines that are missing the Tivoli Storage Manager Client software. The Action Script for this fixlet performs the required steps to install the Tivoli Storage Manager Client on the virtual machines as needed.

Accompanying this article are several .bes files containing sample fixlets for deploying the Tivoli Storage Manager Client. There are separate Tivoli Storage Manager Fixlets for Windows x64 clients, AIX 64-bit clients, and Linux x86-64 clients. Import the appropriate .bes files using the File → Import menu item in the IBM Endpoint Manager Console. After you import the .bes files, the fixlets are displayed in the Systems Lifecycle domain under All Systems LifeCycle → Custom Content → All Custom Content, as shown in Figure 12:

Figure 12. All Custom content view
In Figure 12, the fixlet to deploy the Tivoli Storage Manager 6.3.2 Linux Client is selected. Information for this fixlet is displayed in the view in several tabs. A list of IBM PureApplication System virtual machines is displayed under the Applicable Computers tab. IBM Endpoint Manager determines the list of applicable computers (virtual machines) by using a concept called **Relevance**. In IBM Endpoint Manager, Relevance is a human-readable language that inspects the properties of a virtual machine. Using a fixlet’s Relevance, IBM Endpoint Manager finds all of the known virtual machines that require a resolution to the issue that the fixlet is designed to address. In the case of the Tivoli Storage Manager fixlet, IBM Endpoint Manager shows you a list of virtual machines that are missing the Tivoli Storage Manager Client software.

In Figure 12 above, Tivoli Storage Manager fixlets appear for Windows clients, AIX clients, and Linux clients, because in the example environment, the Relevance of each fixlet matches at least one virtual machine that was discovered by IBM Endpoint Manager. By default, if a fixlet is not relevant to any virtual machines, it is not displayed. For example, if there are no Windows x86-64 virtual machines running in the IBM PureApplication System cloud, then the Deploy Tivoli Storage Manager 6.3.2 Windows Client is not displayed.

Let’s take a closer look at the Relevance of the selected Deploy Tivoli Storage Manager 6.3.2 Linux Client fixlet.

Click the **Edit** tab to display the Relevance Statements for the selected fixlet, as shown in Figure 13. This fixlet contains a number of Relevance Statements, and the Fixlet only becomes relevant to a particular virtual machine if all statements evaluate to true on that virtual machine. The fixlet action is considered successful when the Relevance Statements evaluate to false. The Relevance Statements in the fixlet verify the following facts before making the fixlet relevant:

- The operating system of the virtual machine is Linux.
- The architecture of the virtual machine is x86-64.
- The rpm program exists on the virtual machine.
- The rpm package for Tivoli Storage Manager backup-archive Client V6.3.2 or later is not already installed.
The Tivoli Storage Manager fixlet contains an Action Script that, when deployed on target virtual machines, runs the commands to install the Tivoli Storage Manager Client software on each virtual machine's operating system. To inspect or modify the Action Script, click the Actions tab of the Edit Fixlet dialog. The script is written in the IBM Endpoint Manager Action Language. For more information, see the IBM Endpoint Manager Knowledge Center.

Before running a Tivoli Storage Manager fixlet Action Script on an IBM PureApplication System virtual machine, you must edit the Action Script and link the Action with the Tivoli Storage Manager Client package that you previously created and uploaded.

### Linking the Tivoli Storage Manager Client package to a Tivoli Storage Manager fixlet action

Select the Tivoli Storage Manager fixlet that matches the operating system of your IBM PureApplication System virtual machines. You can view the operating system of each corresponding VM in the Discovered Computers list under OS. Click the Edit tab to open the Edit Fixlet dialog, and then navigate to the Actions tab, where the contents of the Action Script is displayed. The first non-comment command in the script is the prefetch block, as shown in Figure 14.

```plaintext
begin prefetch block
end prefetch block
```
Figure 14. Fixlet Action Script

A prefetch block contains a set of commands for downloading files. In Figure 14, the prefetch block in the provided Action Script is empty. You must include an add prefetch item command to the prefetch block that downloads the Tivoli Storage Manager Client package from the IBM Endpoint Manager Server to the target virtual machine.

Edit the prefetch block and insert the add prefetch item command, using the file size and SHA1 checksum values that you recorded when you created the Tivoli Storage Manager Client package, using the following format:

```
add prefetch item name=TSMClient sha1=<sha1 value> size=<file size in bytes> url=SWDProtocol://127.0.0.1:52311/uploads/<sha1 value>/compressedPackageData.bftemp.bfswd
```

The following example shows a completed prefetch block:

```
begin prefetch block
add prefetch item name=TSMClient sha1=a311849b041802357f685c4811affd15d557b79f size=125679227 url=SWDProtocol://127.0.0.1:52311/uploads/a311849b041802357f685c4811affd15d557b79f /compressedPackageData.bftemp.bfswd
end prefetch block
```

When you finish editing the Action Script, click OK to save your changes. Now that you have linked the Tivoli Storage Manager Client package to the Tivoli Storage Manager fixlet action, you can use the Tivoli Storage Manager fixlet action to install the package on IBM PureApplication System virtual machines.
Deploying an IBM Tivoli Storage Manager backup agent

Select the Tivoli Storage Manager fixlet corresponding to the operating system of your IBM PureApplication System virtual machines listed under the OS column. For the example shown in Figure 15, the Deploy Tivoli Storage Manager 6.3.2 Linux Client fixlet is selected to deploy the Tivoli Storage Manager Client to a relevant virtual machine.

Click **Take Action**, as shown in Figure 12 above. The Take Action dialog is displayed, as shown in Figure 15. Select the virtual machine or machines on which to perform the action, and click **OK**. You can take the action on all virtual machines at once if desired. In this example, only one virtual machine is selected, ausipas111:

**Figure 15. Fixlet applicable computers**

![Fixlet applicable computers](image)

You can monitor the progress of the Action Script in the IBM Endpoint Manager console:
Figure 16. Fixlet action status

When the Action completes on a target virtual machine, the status is updated to Fixed:

Figure 17. Fixlet action status updated to Fixed

If the client fails to deploy, as shown in Figure 18 with an example AIX VM auspower164, then the action returns a status of Failed, and the Action Script execution steps are displayed as Failed. To view these details, select the appropriate completed action under Actions, and double-click on the action status to display the View Action Info page:
The failure shown in Figure 18 is due to an incorrectly specified SHA1 checksum value. To troubleshoot the failure, examine the exit code, if provided, or review the SHA1 checksum value, the URL, or the size of the Tivoli Storage Manager Client file that you uploaded in the software distribution package. Ensure that the correct Tivoli Storage Manager software package version and upload was used for the operating system that matches your IBM PureApplication System virtual machines.

A successful Tivoli Storage Manager Deployment shows the Action Script execution steps as Completed and the status as Fixed, as shown in Figure 19 for the deployment on an AIX VM auspower165:

Following a successful Tivoli Storage Manager Client deployment, when you select the Tivoli Storage Manager Fixlet again in the All Custom Content view, the virtual machines where you deployed the Tivoli Storage Manager Client are no longer in the Applicable Computers list. Figure
Figure 20. Applicable Computers list after Tivoli Storage Manager deployment

This example illustrates how IBM Endpoint Manager simplifies the deployment of backup agents by installing backup agents remotely, showing which virtual machines in the cloud require the backup agent, and filtering out the machines that already have the agent installed.

Configuring an IBM Tivoli Storage Manager backup agent

After deploying a Tivoli Storage Manager Client to IBM PureApplication System virtual machines, you must configure the Tivoli Storage Manager Client backup agent to communicate with the central backup server. The host operating system where the agent resides may also require configuration, and a port may need to be opened in the virtual machine firewall so that the agent can communicate with the Tivoli Storage Manager Server. If the host name or port of the Tivoli Storage Manager Server changes in the future, then the agents and operating system will require reconfiguration on all virtual machines. IBM Endpoint Manager tasks simplify the configuration of backup agents.

In IBM Endpoint Manager, a task is similar to a fixlet. Tasks and fixlets both use Relevance to determine the virtual machines to which they apply, and they both contain Action Scripts that resolve issues on applicable virtual machines. Tasks, however, are designed for reapplication, so they remain relevant to a virtual machine even after their Action Scripts have already been run on that machine. Tasks are appropriate for adjusting configuration settings or for performing regular maintenance.
The .bes files that accompany this article contain tasks for configuring the Tivoli Storage Manager Client and related operating system settings. Separate Tivoli Storage Manager tasks are provided for Linux x86-64 clients, Windows x86-64 clients, and AIX 64-bit clients. Using the provided tasks, you can quickly configure or reconfigure the Tivoli Storage Manager Clients on all virtual machines in the cloud.

After you deploy the Tivoli Storage Manager Client successfully using one of the Tivoli Storage Manager fixlets, a new Tivoli Storage Manager task is displayed automatically in the All Custom Content view.

**Figure 21. All Custom Content view**

In Figure 21, a new task entitled Tivoli Storage Manager Client V6.3.2 Linux Configuration Settings is displayed in the All Custom Content view, as a result of deploying the TSM Client software to the Linux VM, ausipas111. To run the task’s Action Script on a virtual machine, click Take Action. You are then prompted to specify the following information:

- The host name of the Tivoli Storage Manager Server
- The port number of the Tivoli Storage Manager Server

Enter the values that match the settings of your Tivoli Storage Manager Server. The Target tab is displayed, as shown in Figure 22, prompting you to select the virtual machines on which the Action Script will run. Choose one or more IBM PureApplication System virtual machines, and click OK.
Figure 22. Task applicable computers

You can monitor the progress of the Action in the IBM Endpoint Manager console. When the Action on a target virtual machine is completed, the status changes to Completed:
Conclusion

This article showed you can simplify the management of an agent-based backup system in a cloud by using IBM Endpoint Manager for Lifecycle Management. The ability to integrate with IBM PureApplication System enables IBM Endpoint Manager to discover all virtual machines running in an IBM PureApplication System cloud. You can use IBM Endpoint Manager fixlets to deploy backup agents to the virtual machines, and use IBM Endpoint Manager tasks to configure or reconfigure the agents. Sample fixlets and tasks are provided with this article, demonstrating how to deploy and configure a specific backup agent, the Tivoli Storage Manager Client. Configuring the Tivoli Storage Manager Server using the configuration fixlet prompts you to specify the Tivoli Storage Manager Server hostname or IP address, and creates a port in the firewall for Tivoli Storage Manager communications. The modifications that the fixlet actions perform on the target virtual machines are persistent across virtual machines, regardless of reboots.

If you wish to deploy a backup agent other than the Tivoli Storage Manager Client, refer to the Relevance Statements and Action Scripts in the Tivoli Storage Manager Fixlets as a starting point for developing Fixlets based on the desired backup agent.
## Downloads

<table>
<thead>
<tr>
<th>Description</th>
<th>Name</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code sample</td>
<td>Fixlets_TSM.zip</td>
<td>10 KB</td>
</tr>
</tbody>
</table>
Resources

- **IBM PureApplication System, Tivoli Endpoint Manager, and Tivoli Storage Manager**
  - IBM PureApplication System Information Center
    A single portal to all IBM PureApplication System conceptual, task, and reference information on installing, configuring, and using IBM PureApplication System.
  - IBM PureSystems developer resources
    Latest trials, downloads, tutorials, and other developer resources for IBM PureSystems products and services.
  - IBM PureSystems Centre
    Access PureSystems patterns from IBM and IBM Business Partners, updates to systems and patterns, and expertise for maximizing the benefit of systems and patterns.
  - IBM Tivoli Endpoint Manager V9 Knowledge Center
    Installation and configuration guides, including configuration of the Lifecycle Management Domain
  - Download IBM Tivoli Endpoint Manager Server
    BigFix Enterprise Suite Download Center
  - IBM Tivoli Endpoint Manager action language
    Topic from the IBM Endpoint Manager for Lifecycle Management V9 Knowledge Center
  - Acquiring and using license keys for IBM Tivoli Endpoint Manager
    Topic from the IBM Support Portal for IBM Tivoli Endpoint Manager
  - IBM Tivoli Storage Manager Support Portal
    Information about supported clients and devices and any licensing requirements.
  - Download IBM Tivoli Storage Manager Client V6.3.2
    Download from the IBM Support Portal

- **WebSphere resources**
  - developerWorks WebSphere
    Technical resources for developers who use WebSphere and related middleware products. Includes downloads, how-to information, support resources, and a free technical library of tutorials, best practices, IBM Redbooks, and product manuals.
  - Most popular WebSphere trial downloads
    No-charge trial downloads for key WebSphere products.
  - WebSphere forums
    Product-specific forums where you can get answers to your technical questions and share your expertise with other WebSphere users.
  - WebSphere demos
    Download and watch these self-running demos, and learn how WebSphere products can provide business advantage for your company.
  - WebSphere-related articles on developerWorks
    Nearly 3000 tutorials on WebSphere and related technologies by top practitioners and consultants inside and outside IBM. Search for what you need.
  - WebSphere-related books from IBM Press
    Convenient online ordering through Barnes & Noble.
  - WebSphere-related events
    Conferences, trade shows, Webcasts, and other events around the world.
• **developerWorks resources**
  • **Trial downloads for IBM software products**
    No-charge trial downloads for selected IBM® DB2®, Lotus®, Rational®, Tivoli®, and WebSphere® products.
  • **developerWorks blogs**
    Join a conversation with developerWorks users and authors, and IBM developers.
  • **Technical events for developers**
    Conferences, seminars, and technical events to deepen your technical expertise and help you succeed in your software projects.
  • **developerWorks podcasts**
    Listen to interesting and offbeat interviews and discussions with software innovators.
  • **developerWorks on Twitter**
    Check out recent Twitter messages and URLs.
  • **IBM Education Assistant**
    A collection of multimedia educational modules that will help you better understand IBM software products and use them more effectively to meet your business requirements.
About the authors

Katherine J. Lamendola

Katherine Lamendola is a Software Engineer on the IBM PureApplication System development team. You can contact Katherine at kjlamend@us.ibm.com.

Jeffrey T. Klier

Jeffrey Klier is a Software Engineer on the IBM PureApplication System development team. You can contact Jeffrey at jtklier@us.ibm.com.

© Copyright IBM Corporation 2014
Trademarks
(www.ibm.com/developerworks.ibm/trademarks/)